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Technologies
Mr. GOPAL KRISHNA, Sr. Hadoop Technical Architect, BIGDATA Practice - CoE Lead
15+ Years Of Real Time IT Exp, 9+ Years On BIGDATA Projects Exp
CLOUDERA CCA 175 - Spark and Hadoop Certified Consultant

HADOOP COURSE CONTENT - (HADOOP-1.X, 2.X & 3.X)
(Development, Administration & REAL TIME Projects Implementation)

Introduction to BIGDATA and HADOOP
e Whatis Big Data?
e Whatis Hadoop?
» Relation between Big Data and Hadoop.
e Whatis the need of going ahead with Hadoop?
e Scenarios to apt Hadoop Technology in REAL TIME Projects
e Challenges with Big Data
» Storage
» Processing
e How Hadoop is addressing Big Data Changes
e Comparison with Other Technologies
» RDBMS
» Data Warehouse
» TeraData
e Different Components of Hadoop Echo System
» Storage Components
» Processing Components
» Importance of Hadoop Echo System Components in Real Time Projects
e Other solutions of Big Data
» Introduction to NO SQL
» NO SQL vs HADOOP
e Type of BigData Projects
» On Premises project
» Cloud Integrated Project
» Differences between On Premises & Cloud Integrated Projects

HDFS (Hadoop Distributed File System)

e Whatis a Cluster Environment?
e Cluster Vs Hadoop Cluster.
e Significance of HDFS in Hadoop
e Features of HDFS
e Storage aspects of HDFS
» Block - the basic storage unit in hadoop
» How to Configure block size
» Default Vs Configurable Block size
» Why HDFS Block size so large?
» Design Principles of Block Size
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e HDFS Architecture - 5 Daemons of Hadoop

¢« NameNode and its functionality

e DataNode and its functionality

e JobTracker and its functionality

e TaskTrack and its functionality

e Secondary Name Node and its functionality.

e Replication in Hadoop - Fail Over Mechanism
e Data Storage in Data Nodes
e Fail Over Mechanism in Hadoop - Replication
e Replication Configuration
e Custom Replication
e Design Constraints with Replication Factor
e (Can we change the replication factor in Hadoop?
» (Can we change the block size for a file or directory in Hadoop?

e Accessing HDFS
¢ CLI (Command Line Interface) and HDFS Commands
e Java Based Approach
e Hadoop Archives
e Configuration files in Hadoop Installation and the Purpose
e How to & Where to Configure Hadoop Daemons in a Hadoop Cluster?
» Difference between Hadoop 1.X.X, Hadoop 2.X.X & 3.X.X version
e Name Node HA (High Availability in Hadoop 2.X.X)
e Importance of NFS in Hadoop-2.X
e Importance of Journal Nodes in Hadoop-2.X

MapReduce

e Why Map Reduce is essential in Hadoop?
e Processing Daemons of Hadoop
» Job Tracker
v Roles Of Job Tracker
v' Drawbacks w.r.to Job Tracker failure in Hadoop Cluster
v How to configure Job Tracker in Hadoop Cluster
» Task Tracker
v" Roles of Task Tracker
v' Drawbacks w.r.to Task Tracker Failure in Hadoop Cluster

e Input Split
v" InputSplit
v" Need Of Input Split in Map Reduce
v" InputSplit Size
v InputSplit Size Vs Block Size
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v InputSplit Vs Mappers

e Map Reduce Life Cycle

Communication Mechanism of Job Tracker & Task Tracker
Input Format Class

Record Reader Class

Success Case Scenarios

Failure Case Scenarios

Retry Mechanism in Map Reduce

AN NI N NN

e MapReduce Programming Model
e Different phases of Map Reduce Algorithm
o Different Data types in Map Reduce
v Primitive Data types Vs Map Reduce Data types

e How to write a basic Map Reduce Program
e Driver Code
e Mapper Code
e Reducer Code

e Driver Code
v Importance of Driver Code in a Map Reduce program
v" How to Identify the Driver Code in Map Reduce program
v' Different sections of Driver code

e Mapper Code
v" Importance of Mapper Phase in Map Reduce
v How to Write a Mapper Class?
v' Methods in Mapper Class

e Reducer Code
v Importance of Reduce phase in Map Reduce
v" How to Write Reducer Class?
v' Methods in Reducer Class
o IDENTITY MAPPER & IDENTITY REDUCER
e Input Format’'s in Map Reduce
TextInputFormat
KeyValueTextInputFormat
NLineInputFormat
DBInputFormat
SequenceFileInputFormat.
How to use the specific input format in Map Reduce
How to write Custom Input Format Class and Custom Record
Reader
e Output Format’s in Map Reduce
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TextOutputFormat

KeyValueTextOutputFormat

NLineOutputFormat

DBOutputFormat

SequenceFileOutputFormat.

How to use the specific Output format in Map Reduce

How to write Custom Output Format Class and Custom Record

Writer

AN NN

e Map Reduce API(Application Programming Interface)
v" New API
v" Deprecated API

e Combiner in Map Reduce
v Is combiner mandate in Map Reduce
v" How to use the combiner class in Map Reduce
v Performance tradeoffs w.r.to Combiner
v" Real Time Use Cases
v" Where to Use & Where Not to Use Combiner

e Partitioner in Map Reduce

Importance of Practitioner class in Map Reduce
How to use the Partitioner class in Map Reduce
Different types of Practitioners in Map Reducer
Importance of hashPartitioner

How to write a custom Practitioner

Real Time Use Cases
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e Compression Techniques in Map Reduce

Importance of Compression in Map Reduce

What is CODEC

Compression Types

GzipCodec

BzipCodec

LZOCodec

SnappuCodec

Configurations w.r.to Compression Techinques

How to customize the Compression per one job Vs all the job.

AN N N U U N N

e Map Reduce Job Chaining
v" What is Map Reduce Job Chaining?
v Use of MR Chaining in Real Time Hadoop Projects
v" Real Time Use case
v Performance trade off’s using MR Chaining
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e Joins -in Map Reduce

Map Side Join

Reduce Side Join

Performance Trade Off

Real Time applicability of Map Side & Reduce Side Joins in Map
Reduce

v' Distributed cache

AN NANRN

 How to debug MapReduce Jobs in Local and Pseudo cluster Mode.
e Introduction to MapReduce Streaming
e Datalocality in Map Reduce

e Secondary Sorting Using Map Reduce

Apache PIG

e Introduction to Apache Pig
e Map Reduce Vs Apache Pig
e SQL Vs Apache Pig
o Different datat ypes in Pig
e Where to Use Map Reduce and PIG in REAL Time Hadoop Projects
e Modes Of Execution in Pig
v Local Mode
v Map Reduce OR Distributed Mode
e Execution Mechanism
v" Grunt Shell
v’ Script
v" Embedded
e Transformations in Pig
e How to write a simple pig script
e Parameter substitution in PIG Scripts
e XML Processing through PIG
e JSON Processing through PIG
e Importance of DEFINE Keyword in PIG
e How to develop the Complex Pig Script
e Bags, Tuples and fields in PIG
e UDFsin Pig
v" Need of using UDFs in PIG
v" How to use UDFs
v REGISTER Key word in PIG
Techniques to improve the performance and efficiency of Pig Latin Programs

HIVE

e Hive Introduction
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e Need of Apache HIVE in Hadoop
¢  When to choose MAP REDUCE , PIG & HIVE in REAL Time Project
e Hive Architecture
v’ Driver
v' Compiler
v Executor(Semantic Analyzer)

e Meta Store in Hive

Importance Of Hive Meta Store

Embedded Metastore VS External Metastore

Embedded metastore configuration

External metastore configuration

Communication mechanism with Metastore and configuration
details

Drawbacks with Internal/Embedded metastore over External
metastore

AN N NN

<

e Hive Integration with Hadoop

e Hive Query Language(Hive QL)

e Configuring Hive with MySQL MetaStore
e SQL VS Hive QL

e Data Slicing Mechanisms

v' Partitions In Hive
» Static Partitioning in Hive and its performance trade offs
» Dynamic Partitioning in Hive and its performance trade offs
v Buckets In Hive
v' Partitioning with Bucketing usage in Real Time Project Use Cases
v’ Partitioning Vs Bucketing
v" Real Time Use Cases

e Collection Data Types in HIVE
v Array
v" Struct
v' Map
v" Real Time Use Cases
e Conditional Functions in HIVE
v Imporatnce of CASE Statement
v" Real Time Use Cases on CASE Statements
v
e DATE Functions in HIVE

v' Imporatnce of Date Functions
v" Real Time Use Cases on DATE Functions
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e User Defined Functions(UDFs) in HIVE

v' UDFs

v' UDAFs

v' UDTFs

v Need of UDFs in HIVE
e Hive Serializer/Deserializer - SerDe
e Semi Structured Data Processing Using Hive
e Semi Structured Data Processing through HIVE

v" XML Data Processing

v Importance of XML Data Processing through HIVE in Real Time
Projects
JSON (Java Script Object Notation) Data Processing through HIVE
Importance of JSON Data Processing through HIVE in Real Time

Projects
v

e HIVE - HBASE Integration

v Importance of HIVE - HBASE Integration with respect to Latency
v Real Time Use Cases on Hive - HBase Integration

v
v

SQOO0OP

e Introduction to Sqoop.

e MySQL client and Server Installation

e How to connect to Relational Database using Sqoop

e Performance Implications in SQOOP Import and how to improve the
performance

e Performance Implications in SQOOP Export and how to improve the
performance

e Different Sqgoop Commands

e Different flavors of Imports
e Export
e Hive-Imports

SQOOP Incremental Load VS History Load & Limitations in Incremental Load

HBase

e Different BigData Solutions - Hadoop Comparision with Not Only SQL(NO
SQL)

e Hbase introduction

Flat No: 212, 2™ Floor, Annapurna Block, Aditya Enclave, Ameerpet, Hyd
info@kellytechno.com www.kellytechno.com Ph: 998 570 6789. Online: 001 973 780 6789.



@‘Ke"V V _aaa

Technologies

Mr. GOPAL KRISHNA, Sr. Hadoop Technical Architect, BIGDATA Practice - CoE Lead
15+ Years Of Real Time IT Exp, 9+ Years On BIGDATA Projects Exp
CLOUDERA CCA 175 - Spark and Hadoop Certified Consultant
e HDFS Vs HBase

e HBase Vs RDBMS

e HBase Vs Cassandra VS Mongo DB & Real Time Use Cases on applicabiltiy
e Hbase usecases

o Hbase Data modeling Elements

. Column families
¢  Column Qualifier Name
e  Row Key

e HBase Architecture

e Bulk Loading Operation with HBASE

e Importance of ImportTsv Utility in HBase
e Real Time case study on the usage of ImportTSV Utility of HBase
e C(lients

e REST

e Thrift

e Java Based
e Avro

e Map Reduce Integration
e Map Reduce over HBase
e HBase Admin

e Schema Definition
e Basic CRUD Operations
e (lient Side Buffering in HBase

Flume
e Flume Introduction

e Flume Architecture

e Flume Master, Flume Collector and Flume Agent
e Flume Configurations

e Real Time Use Case using Apache Flume

Sentimental Data Analytics with respect to Social Media Data with Flume &
Hive
Oozie

e Oozie Introduction

e QOozie Architectrure

e Oozie Configuration Files

¢ Qozie Job Submission

v Workflow.xml
v Coordinator.xml
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v job.coordinator.properties
v Transit parameters in workflow.xml

YARN (Yet another Resource Negotiator) - Next Gen. Map Reduce
e Whatis YARN?

e Difference between Map Reduce & YARN
e YARN Architecture

v Resource Manager
v Application Master
v" Node Manager
e  When should we go ahead with YARN

e YARN Process flow

e YARN Web Ul

e Different Configuration Files for YARN

e How to access Map Reduce Job History Server and Importance of
Historyserver

e Examples on YARN

Cloudera Impala
e Whatis Impala?

e How can we use Impala for Query Processing?

e  When should we go ahead with Impala

e Data Analytics with respect to Hive Batch Processing VS Impala Real Time
Processing

e REAL TIME Use Cases with Impala

MongoDB ( As part of NoSQL Databases )
¢ Need of NoSQL Databases

o Relational VS Non-Relational Databases

e Introduction to MongoDB

e Features of MongoDB

e Installation of MongoDB

e Mongo DB Basic operations

e REAL Time Use Cases on Hadoop Data Processing & MongoDB Storage

Apache Cassandra
e Introduction to Cassandra

e Mongo DB Vs Cassandra
e Basic Operation using Cassandra
e Comparison among HBase , Mongo DB and Cassandra NO SQL DBs
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Apache Kafka (A Distributed Message Queuing System)
e Introduction to Kafka

e Installation of Kafka
e Difference between MQ Vs Kafka
e Basic Operation using Kafka and real time case study on Kafka usage

Mahout (As a part of BIGDATA ANALYTICS)
e Introduction to Machine Learning (ML) Languages

e Types of Machine Learning

e Introduction to Apache MAHOUT

e (Categories of Mahout Algorithms

Real Time Use case using Classifier Algorithm of Mahout - Naives Bayes

Apache Spark - with Scala Content
[As part of Hadoop Course]

Introduction to SCALA
e Why Scala

e ScalaVs]Java
e Why Scala is a Hybrid Language
e Pre-Requisits for Scala Installation

SCALA Basics
e Scala Data types

e Scala Packages

¢ Runtime environment of Scala & Java
e Different IDE Support for Scala

e Control Structures

Interactive SCALA - SCALA Shell
e Scala REPL [ Real Evaluate Print Loop ]

e Writing Scala Scripts
e Compiling the Scala Programs
e Different IDEs for Scala

SCALA Type Less, Do More
e Var[variable] VS val[Value]

e Type Inference

e DataTyes in SCALA

e Type Casting in Scala
Conditional Statements in SCALA
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e Ifexpression

e If-else expression

e While Loop and Do...While Loop & difference between the two

e Forloop, different forms of for loop in SCALA

e Pattern matching in SCALA & use of case and match keywords in SCALA

Functional Programing in SCALA

e  What is Functional Programming

e Difference between Object Oriented and Functional Programing Paradigm
e C(losures in Scala

e Currying Functions in Scala

e Higher Ordered Functions in Scala

SCALA Environment Set Up

e Scala set up on Linux
e Java Set Up
e ScalaSetUp

SCALA Collections
e List
e Set
e Map

SCALA Object Oriented Programming Introducton

SPARK
e Introduction to Spark

e Motivation for Spark

e Spark Vs Map Reduce Processing

e Architecture Of Spark

e Spark Shell Introduction

e Creating Spark Context

e File Operations in Spark Shell

e (Caching in Spark

e Real time Examples of Spark

e Introduction to Spark Components
v'Spark Core
v'Spark SQL
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v'Spark Streaming

v'Spark MLLib
v'Spark Streaming
e Spark Core

Resilient Distributed Dataset [ RDD]

e What is RDD and why it is important in Spark
e Core Features of RDD
1. Lazily Evaluated
2. Immutable
3. Partitioned
e Different Operation on RDDs
1. Transformations
2. Actions
e Transformation in RDD
e Different Examples on Transformations
e Actions in RDD
o Different examples on Actions
e Loading Data through RDD
e Saving Data
e Key-Value pair RDD
e Pair RDD operations
e Running Spark in a Clustered Mode
e Deploying Application with spark-submit
e (luster Management

Spark SQL
e Introduction to Spark SQL
¢ The SQL Context
e Hive Vs Spark SQL
e Introduction to Data Frames [ DFs |
e Examples on Spark SQL

Different File Formats Processing through Spark SQL
e CSV

« JSON

« PARQUET
« ORC

e TEXT
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Spark SQL Integrations
e Spark - Hive Integration and Real Time use cases on the same

e Spark - RDBMS Integration and Real Time use cases on the same
e Spark - NO SQL Integration Introduction and Importance

Introduction to Big Data Project Integration with AWS Cloud

HADOOP ADMINISTRATION TOPICS
e Hadoop Single Node Cluster Set Up (Hands on Installation on Laptops)
Operating System Installation
JDK Installation
SSH Configuration.
Dedicated Group & User Creation
Hadoop Installation
Different Configuration Files Setting

Name node format
Starting the Hadoop Daemons
e Multi Node Hadoop Cluster Set Up (Hands on Installation on Laptops)

Network related settings
Hosts Configuration
Password less SSH Communication
Hadoop Installation
Configuration Files Setting
Name Node Format
Starting the Hadoop Daemons
e PIG Installation (Hands on Installation on Laptops)
v" Local Mode
v" Clustered Mode
v" Bashrec file configuration
e SQOOP Installation (Hands on Installation on Laptops)
v" Sqoop installation with MySQL Client
e HIVE Installation(Hands on Installation on Laptops)
v" Local Mode
v Clustered Mode
e HBase Installation (Hands on Installation on Laptops)
e Local Mode
e C(Clustered Mode

AN NI N N N Y NN
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e OOZIE Installation (Hands on Installation on Laptops)
e Mongo DB Installation (Hands on Installation on Laptops)
e SPARK Installation (Hands on Installation on Laptops)

e SCALA Installation (Hands on Installation on Laptops)
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e Commissioning Of Nodes In Hadoop Cluster

e Decommissioning Of Nodes from Hadoop Cluster

PRE-REQUISITES FOR THE COURSE
» SQL Commands Basic Knowledge [ FREE SQL Classes will be provided as

part of the course itself]

» Linux Basic Commands [ FREE Classes provided as part of course |

» Java Basics - 00Ps Concepts only [ FREE Java OOPs Concept Classes will
provided as part of course |

What we are offering as part of the Course?

e 3 REAL TIME Hadoop Projects End-to-End Explanation with architecture.

e End to End Hadoop Real Time Project derivation workshop.

e FREE Online Mock Test based on CCA 175 exam.

e Mock Interviews will be conducted on a one-to-one basis after the course
duration.

e Hand Written Hard Copy & Soft Copy Materials for all the Components.

e Detailed Assistance in RESUME Preparation on a one-to-one basis with Real
Time Projects based on your technical back ground.

e All the Real time interview questions and answers will be provided.

e 15 classes for Core Java, Linux and SQL concepts will be covered as part of the
course.

e Discussing the new happenings in Hadoop

e FREE BIGDATA workshops

e Discussing the Interview Questions on a daily basis

e Discussing Certification (CCA 175 - Spark and Hadoop Certification) Related
topics on a daily basis.

e 2 Written Exams will be conducted during the course with Real Time
Scenarios
Which will help a lot where you stand with market standands?

e Academic Projects will be provided for pursuing students.
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